## ACCESS
### Table of Contents

**BASIC BUILDING BLOCKS OF AN ACCESS DATABASE** ........................................ 1

- Tables .................................................................................................................. 1
- Forms .................................................................................................................... 1
- Reports .................................................................................................................. 2
- Macros ................................................................................................................... 2
- Modules .................................................................................................................. 2

**CREATING A DATABASE** .................................................................................... 3

- Create a database by using a template ................................................................. 3
- Download a template from Office Online ............................................................. 4
- Create a database without using a template .......................................................... 5
- Create a blank database .......................................................................................... 5

**CREATING TABLES** .............................................................................................. 6

- Create a table, starting in Datasheet view .............................................................. 6
- Create a table, starting in Design view ................................................................... 7
- Create a table by using a template ......................................................................... 7
- Copy data from another source into an Access table ............................................ 8
- Import, append, or link to data from another source ............................................. 9
- Open an existing Access database ........................................................................ 10
- Create a custom blank template .......................................................................... 12

**Table relationships** ............................................................................................. 14

- Set a table’s key ...................................................................................................... 14
- Benefits of using relationships .............................................................................. 15
- Determine which fields to use as a primary key .................................................... 16
- Set or change the primary key .............................................................................. 16
- Remove the primary key ....................................................................................... 17

**CREATING FORMS** ............................................................................................. 18

- Open Your Access Database ................................................................................ 18
- Select the Table for your Form ............................................................................. 18
Select Create Form from the Access Ribbon ................................................................. 19
View the Basic Form ........................................................................................................ 19
Arrange Your Form Layout ............................................................................................... 19
Format Your Form ............................................................................................................ 20
Use Your Form ................................................................................................................ 20

CREATING REPORTS ........................................................................................................ 22
Choose a record source .................................................................................................... 22
Create a report by using the Report tool ......................................................................... 22
Create a report by using the Report Wizard .................................................................. 23
Create labels by using the Label Wizard ....................................................................... 23
Create a report by using the Blank Report tool ............................................................ 24
Understand the report sections .......................................................................................... 24
Understand controls ......................................................................................................... 25
Fine-tune your report in Layout view ............................................................................... 26
Fine-tune your report in Design view ............................................................................... 27
Add fields from the Field List pane ................................................................................ 27
Add controls to the report ............................................................................................... 28
Create a control by using the tools in the Controls group .............................................. 28
Display the property sheet .............................................................................................. 28
Save your work ................................................................................................................ 29
Save your report design ................................................................................................. 29
Save your report design under a new name .................................................................... 29
View, print, or send your report as an e-mail message .................................................. 29
View your report ............................................................................................................... 29
View your report in Report view ...................................................................................... 30
Work with your data in Report view ............................................................................... 30
Show only the rows you want by using filters ................................................................ 30
Create a more detailed filter ........................................................................................... 30
Toggle a filter on and off ............................................................................................... 31
Remove a filter ............................................................................................................... 31
Preview your report by using Print Preview .................................................................... 31
Print your report ............................................................................................................. 32
Change the page settings ............................................................................................... 32
Send your report to a printer ......................................................................................... 32
Send your report as an e-mail message ......................................................................... 32
DATA COLLECTION .......................................................................................................... 34
   When to use data collection .......................................................................................... 34
   Using The Wizard .......................................................................................................... 35
   Automatic processing .................................................................................................... 42
   Allowing only updates to data ...................................................................................... 43
   Manual processing ......................................................................................................... 43
   Customize the e-mail message ...................................................................................... 47
   Create and send e-mail messages .................................................................................. 48
      After you send the e-mail message ........................................................................... 50
   Viewing replies .............................................................................................................. 50
BASIC BUILDING BLOCKS OF AN ACCESS DATABASE

The basic building blocks are **OBJECTS**. Although Access supports many types of objects, the most common are listed below.

**Tables**

A database table is similar in appearance to a spreadsheet; data is stored in rows and columns. As a result, it is usually quite easy to import a spreadsheet into a database table. The main difference between storing your data in a spreadsheet and storing it in a database is how the data is organized.

To get the most flexibility out of a database, the data needs to be organized into tables so that redundancies don't occur. For example, if you're storing information about employees, each employee should only need to be entered once in a table that is set up just to hold employee data. Data about products will be stored in its own table, and data about branch offices will be stored in another table. This process is called *normalization*.

Each row in a table is referred to as a record. Records are where the individual pieces of information are stored. Each record consists of one or more fields. Fields correspond to the columns in the table. For example, you might have a table named "Employees" where each record (row) contains information about a different employee, and each field (column) contains a different type of information, such as first name, last name, address, and so on. Fields must be designated as a certain data type, whether it's text, date or time, number, or some other type.

**Forms**

Forms are sometimes referred to as "data entry screens." They are the interfaces you use to work with your data, and they often contain command buttons that perform various commands. You can create a database without using forms by simply editing your data in the table datasheets. However, most database users prefer to use forms for viewing, entering, and editing data in the tables.

Forms provide an easy-to-use format for working with the data, and you can also add functional elements, such as command buttons, to them. You can program the buttons to determine which data appears on the form, open other forms or reports, or perform a variety of other tasks. For example, you might have a form named "Customer Form" in which you work with customer data. The customer form might have a button which opens an order form where you can enter a new order for that customer.

Forms also allow you to control how other users interact with the data in the database. For example, you can create a form that shows only certain fields and allows only...
certain operations to be performed. This helps protect data and to ensure that the data is entered properly.

**Reports**

Reports are what you use to summarize and present data in the tables. A report usually answers a specific question, such as "How much money did we receive from each customer this year?" or "What cities are our customers located in?" Each report can be formatted to present the information in the most readable way possible.

A report can be run at any time, and will always reflect the current data in the database. Reports are generally formatted to be printed out, but they can also be viewed on the screen, exported to another program, or sent as e-mail message.

**Macros**

Macros in Access can be thought of as a simplified programming language which you can use to add functionality to your database. For example, you can attach a macro to a command button on a form so that the macro runs whenever the button is clicked. Macros contain actions that perform tasks, such as opening a report, running a query, or closing the database. Most database operations that you do manually can be automated by using macros, so they can be great time-saving devices.

**Modules**

Modules, like macros, are objects you can use to add functionality to your database. Whereas you create macros in Access by choosing from a list of macro actions, you write modules in the Visual Basic for Applications (VBA) (Visual Basic for Applications (VBA): A macro-language version of Microsoft Visual Basic that is used to program Microsoft Windows-based applications and is included with several Microsoft programs.) programming language. A module is a collection of declarations, statements, and procedures that are stored together as a unit. A module can be either a class module or a standard module. Class modules are attached to forms or reports, and usually contain procedures that are specific to the form or report they're attached to. Standard modules contain general procedures that aren't associated with any other object. Standard modules are listed under **Modules** in the Navigation Pane, whereas class modules are not.
CREATING A DATABASE

When you first start Access, or if you close a database without closing Access, the *Getting Started with Microsoft Office Access* shown below will appear.

This page is a starting point from which you can create a new database, open an existing database, or view featured content from Microsoft Office Online.

Create a database by using a template

Access provides you with a wide variety of templates that you can use to speed up the database creation process. A template is a ready-to-use database containing all the tables, queries, forms, and reports needed to perform a specific task. For example, there are templates that you can use to track issues, manage contacts, or keep a record of expenses. Some templates contain a few sample records to help demonstrate their use. Template databases can be used as they are, or you can customize them to better fit your needs.

If one of these templates fits your needs, using it is usually the fastest way to get a database started. However, if you have data in another program that you want to import into Access, you might decide it is better to create a database without using a template. Templates have a data structure already defined, and it might require a lot of work to adapt your existing data to the template's structure.
1. If you have a database open, click the Microsoft Office Button and then click Close Database to display the Getting Started with Microsoft Office Access page.

2. Several featured templates are displayed in the middle of the Getting Started with Microsoft Office Access page, and more become available when you click the links in the Template Categories pane. You can download additional templates from the Office Online Web site.

3. Click the template that you want to use.

4. Access suggests a file name for your database in the File Name box — you can change the file name, if you want. To save the database in a different folder from the one displayed below the file name box, click , browse to the folder in which you want to save it, and then click OK.

5. Click Create (or Download, for an Office Online template).

Access creates or downloads the database and then opens it. A form is displayed in which you can begin entering data. If your template contains sample data, you can delete each record by clicking the record selector (the shaded box or bar just to the left of the record), and then doing the following:

On the Home tab, in the Records group, click Delete.

6. To begin entering data, click in the first empty cell on the form and begin typing. Use the Navigation Pane to browse for other forms or reports that you might want to use.

Download a template from Office Online

If you can't find a template that fits your needs on the Getting Started with Microsoft Office Access page, and you are connected to the Internet, you can explore the Office Online Web site for a larger selection.

1. On the Getting Started with Microsoft Office Access page, under More on Office Online, click Templates.

The Templates home page on Office Online is displayed in your browser window.

2. Use the Office Online navigation and search tools to find the Access template that you would like to use, and follow the instructions to download it. When you download a template, a database file is downloaded to your computer and opened in a new instance of Access. In most cases, the template is designed to open a data entry form so that you can begin entering data immediately.
Create a database without using a template

If you are not interested in using a template, you can create a database by building your own tables, forms, reports, and other database objects. In most cases, this usually involves one or both of the following:

- Entering, pasting, or importing data into the table that is created when you create a new database, and then repeating the process with new tables that you create by using the **Table** command on the **Create** tab.
- Importing data from other sources and creating new tables in the process.

Create a blank database

1. **On the Getting Started with Microsoft Office Access page, under New Blank Database, click Blank Database.**

2. **In the Blank Database pane, type a file name in the File Name box. If you do not supply a file name extension, Access adds it for you. To change the location of the file from the default, click **Browse for a location to put your database** (next to the File Name box), browse to the new location, and then click **OK**.**

3. **Click Create.**

   Access creates the database with an empty table named Table1, and then opens Table1 in Datasheet view. The cursor is placed in the first empty cell in the **Add New Field** column.

4. Begin typing to add data, or you can paste data from another source.

5. Entering information in Datasheet view is designed to be very similar to working in a Microsoft Office Excel 2007 worksheet. The table structure is created while you enter data — any time you add a new column to the table, a new field is defined. Access automatically sets each field's data type, based on the data you enter.

   If you do not want to enter information in Table1 at this time, click **Close**. If you made any changes to the table, Access prompts you to save changes to the table. Click **Yes** to save your changes, click **No** to discard them, or click **Cancel** to leave the table open.

**IMPORTANT** If you close Table1 without saving it at least once, Access deletes the entire table, even if you have entered data in it.
CREATING TABLES

You can add new tables to an existing database by using the commands in the Tables group on the Create tab.

Create a table, starting in Datasheet view

In Datasheet view, you can enter data immediately and let Access build the table structure behind the scenes. Field names are assigned numerically (Field1, Field2, and so on), and Access automatically sets each field's data type, based on the data you enter.

1. On the Create tab, in the Tables group, click Table.  
   Access creates the table and selects the first empty cell in the Add New Field column.
   
   **NOTE** If you don't see an Add New Field column, you might be in Design view instead of Datasheet view. To switch to Datasheet view, double-click the table in the Navigation Pane. Access prompts you to save the new table, and then switches to Datasheet view.

   Access displays the Field Templates pane, which contains a list of commonly used field types. If you double-click or drag one of these fields into your datasheet, Access adds a field by that name and sets its properties to appropriate values for that type of field. You can change the properties later, if you want. If you drag the field, you must drag it onto an area of the datasheet that contains data. A vertical insertion bar appears, showing you where the field will be placed.

3. To add data, begin typing in the first empty cell, or paste data from another source.

4. To rename a column (field), double-click the column heading, and then type the new name.

   It is a good practice to give a meaningful name to each field, so that you can tell what it contains when you see it in the Field List pane.
5. To move a column, click its heading to select the column, and then drag the column to the location you want.

You can also select multiple adjoining columns and then drag them to a new location all at once. To select multiple adjoining columns, click the column header of the first column, and then, while holding down SHIFT, click the column header of the last column.

**Create a table, starting in Design view**

In Design view, you first create the new table’s structure. You then switch to Datasheet view to enter data, or enter data by using some other method, such as pasting, or importing.

1. On the **Create** tab, in the **Tables** group, click **Table Design**.

2. For each field in your table, type a name in the **Field Name** column, and then select a data type from the **Data Type** list.

   **NOTE** If you don't see the **Field Name** and **Data Type** columns, you might be in Datasheet view instead of Design view. To switch to Design view, right-click the table in the Navigation Pane, and then click **Design View**. Access prompts you for a name for the new table, and then switches to Design view.

3. If you want, you can type a description for each field in the **Description** column. The description is then displayed on the status bar when the cursor is located in that field in Datasheet view. The description is also used as the status bar text for any controls in a form or report that you create by dragging the field from the **Field List** pane, and for any controls that are created for that field when you use the Form Wizard or Report Wizard.

4. After you have added all of your fields, save the table:
   - Click the **Microsoft Office Button** and then click **Save**, or press CTRL+S.

5. You can begin typing data in the table at any time by switching to Datasheet view and clicking in the first empty cell. You can also paste data from another source.

**Create a table by using a template**

Access provides templates for commonly-used types of tables. With a single mouse click, you can create a complete table structure with fields already configured and ready for use. If needed, you can then add or remove fields so that the table fits your needs.

1. On the **Create** tab, in the **Tables** group, click **Table Templates** and then select one of the available templates from the list.
2. To add data, begin typing in the first empty cell or paste data from another source.

- **To delete a column**

  Right-click the column heading and then click **Delete Column**.

- **To add a new column**

  On the **Datasheet** tab, in the **Fields & Columns** group, click **New Field**.

  Access displays the **Field Templates** pane, which contains a list of commonly used field types. If you double-click or drag one of these fields into your datasheet, Access adds a field by that name and sets its properties to appropriate values for that type of field. You can change the properties later, if you want. If you drag the field, you must drag it onto an area of the datasheet that contains data. A vertical insertion bar appears, showing you where the field will be placed.

3. Save the table:

- Click the **Microsoft Office Button** and then click **Save**, or press CTRL+S.

**Copy data from another source into an Access table**

If your data is currently stored in another program, such as Office Excel 2007, you can copy and paste it into an Access table. In general, this works best if your data is already separated into columns, as they are in an Excel worksheet. If your data is in a word processing program, it is best to separate the columns of data by using tabs, or to convert the data into a table in the word processing program before you copy the data. If your data needs any editing or manipulation (for example, separating full names into first and last names), you might want to do this before copying the data, particularly if you are not familiar with Access.

When you paste data into an empty table, Access sets the data type of each field according to what kind of data it finds there. For example, if a pasted field contains nothing but date values, Access applies the Date/Time data type to that field. If the pasted field contains only the words "yes" and "no", Access applies the Yes/No data type to the field.

Access names the fields depending on what it finds in the first row of pasted data. If the first row of pasted data is similar in type to the rows that follow, Access determines that the first row is part of the data and assigns the fields generic names (F1, F2, and so on). If the first row of pasted data is not similar to the rows that follow, Access
determines that the first row consists of field names. Access names the fields accordingly and does not include the first row in the data.

If Access assigns generic field names, you should rename the fields as soon as possible to avoid confusion. Use the following procedure:

1. Save the table.
   - Click the **Microsoft Office Button** and then click **Save**, or press **CTRL+S**.
2. In Datasheet view, double-click each column heading, and then type a valid field name for each column. It might look as though you are typing over data, but the column heading row contains field names, not data.
3. Save the table again.

   **NOTE** You can also rename the fields by switching to Design view and editing the field names there. To switch to Design view, right-click the table in the Navigation Pane and click **Design View**. To switch back to Datasheet view, double-click the table in the Navigation Pane.

**Import, append, or link to data from another source**

You might have data that is stored in another program, and you would like to import that data into a new table or append it to an existing table in Access. Or you might work with people who keep their data in other programs, and you want to work with it in Access by linking to it. Either way, Access makes it easy to work with data from other sources. You can import data from an Excel worksheet, from a table in another Access database, or from a variety of other sources. The process you use differs slightly, depending on your source, but the following procedure will get you started.

1. In Access, on the **External Data** tab, in the **Import** group, click the command for the type of file that you are importing.

   ![Import Options]

   For example, if you are importing data from an Excel worksheet, click **Excel**. If you don't see the program type that you need, click **More**.

   **NOTE** If you can't find the correct format type in the **Import** group, you might need to start the program in which you originally created the data and then use that program to save the data in a common file format (such as a delimited text
file (delimited text file: A file containing data where individual field values are separated by a character, such as a comma or a tab.) before you can import that data into Access.

2. In the Get External Data dialog box, click Browse to find the source data file, or type the full path of the source data file in the File name box.

3. Click the option that you want (all programs allow you to import, and some allow you to append or link) under Specify how and where you want to store the data in the current database. You can create a new table that uses the imported data or (with some programs) you can append the data to an existing table or create a linked table that maintains a link to the data in the source program.

4. If a wizard starts, follow the instructions on the next few pages of the wizard. On the last page of the wizard, click Finish.

If you import objects or link tables from an Access database, either the Import Objects or Link Tables dialog box appears. Choose the items you want and click OK.

The exact process depends on whether you choose to import, append, or link data.

5. Access prompts you about whether you want to save the details of the import operation that you just completed. If you think that you will be performing this same import operation again in the future, click Save import steps, and then enter the details. You can then easily repeat the operation at a later time by clicking Saved Imports in the Import group on the External Data tab. If you don't want to save the details of the operation, click Close.

If you chose to import a table, Access imports the data into a new table and then displays the table under the Tables group in the Navigation Pane. If you chose to append data to an existing table, the data is added to that table. If you chose to link to data, Access creates a linked table under the Tables group in the Navigation Pane.

Open an existing Access database

1. Click the Microsoft Office Button, and then click Open.
2. In the Open dialog box, browse to the database that you want to open.
3. Do one of the following:
   - Double-click the database to open it in the default mode specified in the Access Options dialog box. Click Open to open the database for shared access in a multi-user environment so that you and other users can read and write to the database.
• Click the arrow next to the **Open** button and then click **Open Read-Only** to open the database for read-only access so that you can view but not edit it. Other users can still read and write to the database.

• Click the arrow next to the **Open** button and then click **Open Exclusive** to open the database with exclusive access. When you have a database open with exclusive access, anyone else who tries to open the database receives a "file already in use" message.

• Click the arrow next to the **Open** button and then click **Open Exclusive Read-Only** to open the database for read-only access. Other users can still open the database, but they are limited to read-only mode.

**If you can't find the database that you want to open**

1. In the **Open** dialog box, click **My Computer** or, click **My Computer** in the **Look in** drop-down list.
2. In the list of drives, right-click the drive that you think might contain the database, and then click **Search**.
3. Type your search criteria in the **Search Results** dialog box, and then click **Search** to search for the database.
4. If the database is found, double-click it to open it.
5. You must click **Cancel** in the **Open** dialog box for the database to open. Then, close the **Search Results** dialog box.

**NOTE** You can directly open a data file in an external file format, such as dBASE, Paradox, Microsoft Exchange, or Excel. You can also directly open any ODBC data source (ODBC data source: Data and the information needed to access that data from programs and databases that support the Open Database Connectivity (ODBC) protocol.), such as Microsoft SQL Server or Microsoft FoxPro. Access automatically creates a new Access database in the same folder as the data file, and adds links to each table in the external database.

**Tips**

To open one of the most recently opened databases, click the file name for that database in the **Open Recent Database** list on the **Getting Started with Microsoft Office Access** page. Access opens the database with the same option settings that it had the last time you opened it. If the list of recently used files is not displayed, click the **Microsoft Office Button**  and then click **Access Options**. In the **Access Options** dialog box, click **Advanced**. Under **Display**, enter the number of documents to display in the Recent Documents list, up to a maximum of nine.
If you are opening a database by clicking the Microsoft Office Button and then using the Open command, you can view a list of shortcuts to databases that you have previously opened by clicking My Recent Documents in the Open dialog box.

Create a custom blank template

When you create a new blank database, Access opens a new table in which you can enter data, but it creates no other objects in the database. If you want other objects, such as forms, reports, macros, or additional tables, present in all new databases you create, you can create a custom blank template that contains those objects. Then, the next time you create a new database, it will already contain those objects in your template. In addition to these objects, the template can include tables pre-populated with data, as well as any special configuration settings, database properties, references, or code that you want to have in all new databases.

You can create blank templates in the Office Access 2007 file format, the Access 2002-2003 file format, or the Access 2000 file format. The template must be named Blank.accdb for the Office Access 2007 file format, and Blank.mdb for the earlier file formats.

If the default file format is set to Access 2000 or Access 2002-2003, Access uses Blank.mdb as the blank template file name. The new database is created in the same file format as Blank.mdb. For example, even if your default file format is Access 2000, if the template named Blank.mdb is in Access 2002-2003 file format, any new databases you create will be in Access 2002-2003 format.

If your default file format is set to Access 2007, Access uses Blank.accdb as the file name for the blank template.

How do I change the default file format?

1. Click the Microsoft Office Button, and then click Access Options.
2. In the Access Options dialog box, click Popular.
3. Under Creating databases, select the format you want from the Default file format drop-down list.

To create a blank template, do one of the following:

Create a new database (you can name it Blank or give it a temporary name), and then import or create the objects you want to include in the template.

Make a copy of an existing database that already contains the objects you want in the template, and then delete any objects you don't want.
After you have the objects you want in the template, you must save it to a specific location.

1. Click the **Microsoft Office Button**, and then point to **Save As**.

2. Under **Save the database in another format**, click the file format you want for the template.

3. In the **Save As** dialog box, browse to one of these two template folders:
   - **System template folder** For example, C:\Program Files\Microsoft Office\Templates\1033\Access
   - **User template folder** For example:
     - **In Windows Vista** c:\Users\user name\AppData\Roaming\Microsoft\Templates
     - **In Microsoft Windows Server 2003 or Microsoft Windows XP** C:\Documents and Settings\user name\Application Data\Microsoft\Templates

   **NOTE** A blank template in the System template folder overrides blank templates in any user template folders.

4. In the **File name** box, type **Blank.accdb** (or **Blank.mdb**, if you are creating an earlier-version template), and then click **Save**.

Now that the new template is in place, when you create a new blank database, the objects in the template are included in any new database you create by default. Access opens a new table in Datasheet view, as it does when you create new blank databases without using a template.

To stop using the blank template, delete or rename the file named Blank.accdb (or Blank.mdb, for earlier versions of Access).
Table relationships

Although each table stores data about a different subject, tables in a database usually store data about subjects that are related to each other. For example, a database might contain:

- A customers table that lists your company’s customers and their addresses.
- A products table that lists the products that you sell, including prices and pictures for each item.
- An orders table that tracks customer orders.

Because you store data about different subjects in separate tables, you need some way to tie the data together so that you can easily combine related data from those separate tables. To connect the data stored in different tables, you create relationships. A relationship is a logical connection between two tables that specifies fields that the tables have in common.

Set a table’s key

Fields that are part of a table relationship are called keys. A key usually consists of one field, but may consist of more than one field. There are two kinds of keys:

Primary key A table can have only one primary key. A primary key consists of one or more fields that uniquely identify each record that you store in the table. Often, there is a unique identification number, such as an ID number, a serial number, or a code, that serves as a primary key. For example, you might have a Customers table where each customer has a unique customer ID number. The customer ID field is the primary key of the Customers table. When a primary key contains more than one field, it is usually composed of pre-existing fields that, taken together, provide unique values. For example, you might use a combination of last name, first name, and birth date as the primary key for a table about people.

Foreign key A table can also have one or more foreign keys. A foreign key contains values that correspond to values in the primary key of another table. For example, you might have an Orders table in which each order has a customer ID number that corresponds to a record in a Customers table. The customer ID field is a foreign key of the Orders table.

The correspondence of values between key fields forms the basis of a table relationship. You use a table relationship to combine data from related tables. For example, suppose that you have a Customers table and an Orders table. In your Customers table, each record is identified by the primary key field, ID.
To associate each order with a customer, you add a foreign key field to the Orders table that corresponds to the ID field of the Customers table, and then create a relationship between the two keys. When you add a record to the Orders table, you use a value for customer ID that comes from the Customers table. Whenever you want to view any information about an order's customer, you use the relationship to identify which data from the Customers table corresponds to which records in the Orders table.

A table relationship, shown in the Relationships window.
1 A primary key, identified by the key icon next to the field name.
2 A foreign key — note the absence of the key icon.

**Benefits of using relationships**

Keeping data separated in related tables produces the following benefits:

- **Consistency**  Because each item of data is recorded only once, in one table, there is less opportunity for ambiguity or inconsistency. For example, you store a customer's name only once, in a table about customers, rather than storing it repeatedly (and potentially inconsistently) in a table that contains order data.

- **Efficiency**  Recording data in only one place means you use less disk space. Moreover, smaller tables tend to provide data more quickly than larger tables. Finally, if you don't use separate tables for separate subjects, you will introduce null values (the absence of data) and redundancy into your tables, both of which can waste space and impede performance.

- **Comprehensibility**  The design of a database is easier to understand if the subjects are properly separated into tables.
Plan your tables with relationships in mind. You can use the Lookup Wizard to create a foreign key field if the table that contains the corresponding primary key already exists. The Lookup Wizard creates the relationship for you.

**Determine which fields to use as a primary key**

Sometimes, you might already have data that you want to use as a primary key. For example, you may have existing ID numbers for your employees. If you create a table to track employee information, you might decide to use the existing employee ID as the primary key for the table. Or, perhaps employee ID is only unique in combination with department ID, requiring that you use both fields together as the primary key. A good candidate for the primary key has the following characteristics:

- Each record has a unique value for the field or combination of fields.
- The field or combination of fields is never empty or null — there is always a value.
- The values do not change.

If no suitable data exists to use as a primary key, you can create a new field to use as a primary key. When you create a new field to use as a primary key, set the field's data type to AutoNumber to help make sure that it meets the three characteristics in the preceding list.

**Set or change the primary key**

1. Select the table whose primary key you want to set or change.
2. On the **Home** tab, in the **Views** group, click **View**, and then click **Design View**.
3. In the table design grid, select the field or fields that you want to use as the primary key.
   
   To select one field, click the row selector (row selector: A small box or bar that, when clicked, selects an entire row in table or macro Design view, or when you sort and group records in report Design view.) for the field that you want.

   To select more than one field, hold down CTRL, and then click the row selector for each field.

4. On the **Design** tab, in the **Tools** group, click **Primary Key**.
A key indicator appears to the left of the field or fields that you specify as the primary key.

### Remove the primary key

Unless you have a specific reason not to, you should specify a primary key for a table. Access automatically creates an index for the primary key, which can help improve database performance. Access also makes sure that every record has a value in the primary key field, and that the value is always unique. Unique values are crucial, because otherwise there is no way to reliably distinguish a particular row from other rows.

When you create a new table in Datasheet view, Access automatically creates a primary key for you and assigns it a field name of ID and the AutoNumber data type.

In Design view, you can change or remove the primary key, or set the primary key for a table that doesn't already have one.

1. Select the table whose primary key you want to remove.
2. On the **Home** tab, in the **Views** group, click **View**, and then click **Design View**.
3. Click the row selector (row selector: A small box or bar that, when clicked, selects an entire row in table or macro Design view, or when you sort and group records in report Design view.) for the current primary key. If the primary key consists of multiple fields, hold down CTRL, and then click the row selector for each field.
4. On the **Design** tab, in the **Tools** group, click **Primary Key**.

The key indicator is removed from the field or fields that you previously specified as the primary key.

**NOTE** When you save a new table without setting a primary key, Access prompts you to create a new field for the primary key. If you click **Yes**, Access creates an ID field that uses the AutoNumber data type to provide a unique value for each record. If your table already includes an AutoNumber field, Access uses it as the primary key. If you click **No**, Access does not add a field, and no primary key is set.
CREATING FORMS

Open Your Access Database

Before you begin the form creation process, it's easiest if you pre-select the table that you'd like to base your form upon. Using the "All Tables" pane on the left side of the screen, locate the appropriate table and double-click on it.

Select the Table for your Form
Select Create Form from the Access Ribbon

Next, select the Create tab on the Access Ribbon and choose the Create Form button, as shown in the image above.

View the Basic Form

Access will now present you with a basic form based upon the table you selected. If you're looking for a quick form, this may be good enough. If that's the case, go ahead and skip to the last step.

Arrange Your Form Layout

After your form is created, you'll be placed immediately into Layout View, where you can change the arrangement of your form. If, for some reason, you're not in Layout View, choose it from the drop-down box underneath the Office button.
From this view, you'll have access to the Form Layout Tools section of the Ribbon. Choose the Format tab and you'll see the icons shown in the image above.

While in Layout View, you can rearrange fields on your form by dragging and dropping them to their desired location. If you want to completely remove a field, right-click on it and choose the Delete menu item.

Explore the icons on the Arrange tab and experiment with the various layout options. When you're done, move on to the next step.

**Format Your Form**

Now that you've arranged the field placement on your Microsoft Access form, it's time to apply customized formatting.

You should still be in Layout View at this point in the process. Go ahead and click the Format tab on the ribbon and you'll see the icons shown in the image above.

You can use these icons to change the color and font of text, the style of gridlines around your fields, include a logo and many other formatting tasks.

Explore all of these options and customize your form to satisfy your needs. When you're finished, move on to the next step.

**Use Your Form**
To use your form, you first need to switch into Form View. Click the drop-down arrow on the Views section of the Ribbon, as shown in the figure above. Select Form View and you'll be ready to use your form.

Once you're in Form View, you can navigate through the records in your table by using the Record arrow icons at the bottom of the screen or entering a number into the "1 of x" textbox. You can edit data as you view it, if you like. You can also create a new record by either clicking the icon at the bottom of the screen with a triangle and star or simply using the next record icon to navigate past the last record in the table.
CREATING REPORTS

You can create a variety of different reports in Microsoft Office Access 2007, ranging from the simple to the complex. Begin by thinking about your report’s record source. Whether your report is a simple listing of records or a grouped summary of sales by region, you must first determine which fields contain the data you want to see in your report, and in which tables or queries they reside.

After you choose your record source, you will usually find it is easiest to create your report by using the Report Wizard. The Report Wizard is a feature in Access that guides you through a series of questions and then generates a report based on your answers.

Choose a record source

A report consists of information that is pulled from tables or queries, as well as information that is stored with the report design, such as labels, headings, and graphics. The tables or queries that provide the underlying data are also known as the report’s record source. If the fields that you want to include all exist in a single table, use that table as the record source. If the fields are contained in more than one table, you need to use one or more queries as the record source. Those queries may already exist in your database, or you may need to create new queries specifically to fit the needs of your report.

Create a report by using the Report tool

The Report tool provides the fastest way for you to create a report, because it generates a report immediately without prompting you for information. The report displays all the fields from the underlying table or query. The Report tool may not create the final, polished product that you ultimately want, but it is quite useful as a means to quickly look at the underlying data. You can then save the report and modify it in Layout view or Design view so that it better serves your purposes.

1. In the Navigation Pane, click the table or query on which you want to base the report.

After viewing the report, you can save it and then close both the report and the underlying table or query that you used as a record source. The next time that you open the report, Access will display the most recent data from your record source.
Create a report by using the Report Wizard

You can use the Report Wizard to be more selective about what fields appear on your report. You can also specify how the data is grouped and sorted, and you can use fields from more than one table or query, provided you have specified the relationships between the tables and queries beforehand.


When you preview the report, you see the report as it will appear in print. You can also increase the magnification to zoom in on details.

NOTE If you want to include fields from multiple tables and queries in your report, do not click Next or Finish after you select the fields from the first table or query on the first page of the Report Wizard. Instead, repeat the steps to select a table or query, and click any additional fields that you want to include in the report. Then, click Next or Finish to continue.

Create labels by using the Label Wizard

Use the Label Wizard to easily create labels for a wide variety of standard label sizes.

1. In the Navigation Pane, open the table or query that will be the record source for your labels by double-clicking it.
2. On the Create tab, in the Reports group, click Labels.
3. Follow the directions on the pages of the Label Wizard. On the last page, click Finish.

Access displays your labels in Print Preview so that you can see them as they will appear when they are printed. You can use the slider control on the Access status bar to zoom in on details.

NOTE Print Preview is the only view you can use to see multiple columns — the other views show the data in a single column.
Create a report by using the Blank Report tool

If you aren't interested in using the Report tool or the Report Wizard, you can use the Blank Report tool to build a report from scratch. This can be a very quick way to build a report, especially if you plan to put only a few fields on your report. The following procedure explains how to use the Blank Report tool:


   A blank report is displayed in Layout view, and the Field List (field list: A window that lists all the fields in the underlying record source or database object, except in data access page Design view. In data access page Design view, it lists all the record sources and their fields in the underlying database.) pane is displayed on the right side of the Access window.

2. In the Field List pane, click the plus sign next to the table or tables containing the fields that you want to see on the report.

3. Drag each field onto the report one at a time, or hold down CTRL and select several fields, and then drag them onto the report at the same time.

4. Use the tools in the Controls group on the Format tab to add a logo, title, page numbers, or the date and time to the report.

Understand the report sections

In Access, the design of a report is divided into sections. You can view your report in Design view to see its sections. To create useful reports, you need to understand how each section works. For example, the section in which you choose to place a calculated control determines how Access calculates the results. The following list is a summary of the section types and their uses:

- **Report Header**  This section is printed just once, at the beginning of the report. Use the report header for information that might normally appear on a cover page, such as a logo, a title, or a date. When you place a calculated control that uses the Sum aggregate function in the report header, the sum calculated is for the entire report. The report header is printed before the page header.

- **Page Header**  This section is printed at the top of every page. For example, use a page header to repeat the report title on every page.
**Group Header**  This section is printed at the beginning of each new group of records. Use the group header to print the group name. For example, in a report that is grouped by product, use the group header to print the product name. When you place a calculated control that uses the **Sum** aggregate function in the group header, the sum is for the current group.

**Detail**  This section is printed once for every row in the record source. This is where you place the controls that make up the main body of the report.

**Group Footer**  This section is printed at the end of each group of records. Use a group footer to print summary information for a group.

**Page Footer**  This section is printed at the end of every page. Use a page footer to print page numbers or per-page information.

**Report Footer**  This section is printed just once, at the end of the report. Use the report footer to print report totals or other summary information for the entire report.

**NOTE**  In Design view, the report footer appears below the page footer. However, when the report is printed or previewed, the report footer appears **above** the page footer, just after the last group footer or detail line on the final page.

**Understand controls**

Controls are objects that display data, perform actions, and let you view and work with information that enhances the user interface, such as labels and images. Access supports three types of controls: bound, unbound, and calculated:

**Bound control**  A control whose source of data is a field in a table or query is a bound control. You use bound controls to display values from fields in your database. The values can be text, dates, numbers, Yes/No values, pictures, or graphs. A text box is the most common type of bound control. For example, a text box on a form that displays an employee's last name might get this information from the Last Name field in the Employees table.

**Unbound control**  A control that doesn't have a source of data (a field or expression) is an unbound control. You use unbound controls to display information, lines, rectangles, and pictures. For example, a label that displays the title of a report is an unbound control.

**Calculated control**  A control whose source of data is an expression rather than a field is a calculated control. You specify the value that you want in the control by defining an **expression** as the source of data for the control. An expression is a combination of operators (such as = and +), control names, field names, functions that return a single value, and constant values. For example, the following expression calculates the price of an item with a 25 percent discount by multiplying the value in the Unit Price field by a constant value (0.75).
An expression can use data from a field in the report's underlying table or query, or from a control in the report.

When you create a report, it is probably most efficient to add and arrange all the bound controls first, especially if they make up the majority of the controls on the report. You can then add the unbound and calculated controls that complete the design by using the tools in the Controls group on the Design tab.

You bind a control to a field by identifying the field from which the control gets its data. You can create a control that is bound to the selected field by dragging the field from the Field List pane to the report. The Field List pane displays the fields of the report's underlying table or query. To display the Field List pane, on the Design tab, in the Controls group, click Add Existing Field.

Alternatively, you can bind a field to a control by typing the field name in the control itself or in the box for the ControlSource value in the control's property sheet. The property sheet defines the characteristics of the control, such as its name, the source of its data, and its format.

Using the Field List pane is the best way to create a control for two reasons:

A bound control has an attached label, and the label takes the name of the field (or the caption defined for that field in the underlying table or query) as its caption by default, so you don't have to type the caption yourself.

A bound control inherits many of the same settings as the field in the underlying table or query (such as for the Format, DecimalPlaces, and InputMask properties). Therefore, you can be sure that these properties for the field remain the same whenever you create a control that is bound to that field.

If you already created an unbound control and want to bind it to a field, set the control's ControlSource property to the name of the field.

**Fine-tune your report in Layout view**

After you create a report, you can easily fine-tune its design by working in Layout view. Using the actual report data as your guide, you can adjust the column widths, rearrange the columns, and add grouping levels and totals. You can place new fields on the report design and set the properties for the report and its controls.

To switch to Layout view, right-click the report name in the Navigation Pane and then click Layout View.

Access shows the report in Layout view.
You can use the property sheet to modify the properties for the report and its controls and sections. To display the property sheet, press F4.

You can use the **Field List** pane to add fields from the underlying table or query to your report design. To display the **Field List** pane, do one of the following:

- On the **Format** tab, in the **Controls** group, click **Add Existing Fields**. Press ALT+F8.

You can then add fields by dragging them from the **Field List** pane to the report.

**Fine-tune your report in Design view**

You can also fine-tune your report’s design by working in Design view. You can add new controls and fields to the report by adding them to the design grid. The property sheet gives you access to a large number of properties that you can set to customize your report.

To switch to Design view, right-click the report name in the Navigation Pane and then click **Design View**.

Access shows the report in Design view.

You can use the property sheet to modify the properties for the report itself and the controls and sections it contains. To display the property sheet, press F4.

You can use the **Field List** pane to add fields from the underlying table or query to your report design. To display the **Field List** pane, do one of the following:

- On the **Format** tab, in the **Controls** group, click **Add Existing Fields**. Press ALT+F8.

You can then add fields by dragging them from the **Field List** pane to the report.

**Add fields from the Field List pane**

- To add a single field, drag the field from the **Field List** pane to the section where you want it displayed on the report.
- To add several fields at once, hold down CTRL and click the fields that you want. Then, drag the selected fields onto the report.

When you drop the fields onto a report section, Access creates a bound text box control for each field and automatically places a label control beside each field.
**Add controls to the report**

Some controls are created automatically, such as the bound text box control that is created when you add a field from the **Field List** pane to your report. Many other controls can be created in Design view by using the tools in the **Controls** group on the **Design** tab.

**Determine the name of a tool**

Place the mouse pointer over the tool.

Access displays the name of the tool.

**Create a control by using the tools in the Controls group**

1. Click the tool for the type of control that you want to add. For example, to create a check box, click the **Check Box** tool.

2. Click in the report design grid where you want to position the upper-left corner of the control. Click once to create a default-sized control, or click the tool and then drag in the report design grid to create a control of the size that you want.

3. If you don't position the control perfectly on the first try, you can move it by using the following procedure:
   - 1. Click the control to select it.
   - 2. Position the mouse pointer over the edge of the control until the pointer turns into a four-headed arrow.
   - 3. Drag the control to the location that you want.

This procedure creates an "unbound" control. If the control is the type that can display data (a text box or check box, for example), you need to enter a field name or expression in the **ControlSource** property for the control before it will display any data.

**Display the property sheet**

To display the property sheet in Design view, do one of the following:

On the **Design** tab, in the **Show/Hide** group, click **Property Sheet**. Press F4.
Save your work

After you save your report design, you can run the report as often as you need to. The report’s design stays the same, but you get current data every time you print the report. If your reporting needs change, you can modify the report design or create a new, similar report based on the original.

Save your report design

1. Click the Microsoft Office Button and then click Save, or press CTRL+S. Alternatively, click Save on the Quick Access Toolbar.

2. If the report is untitled, type a name in the Report Name box, and then click OK.

Save your report design under a new name

1. Click the Microsoft Office Button, and then click Save As.

2. In the Save As dialog box, type a name in the Save Report to box, select Report in the As box, and then click OK.

View, print, or send your report as an e-mail message

After you save your report design, you can use it over and over again. The report’s design stays the same, but you get current data every time you view or print the report. If your reporting needs change, you can modify the report design or create a new, similar report based on the original.

View your report

There are several ways to view your report. Which method you choose depends on what you want to do with the report and its data:

If you want to make temporary changes to which data appears on the report before you print it, or if you want to copy data from the report to the clipboard, use Report view.

If you want to be able to change the design of the report while looking at the data, use Layout view.

If you simply want to see what the report will look like when it is printed, use Print Preview.
NOTE If your report is formatted with multiple columns, you can only see the column layout in Print Preview. Layout view and Report view display the report as a single column.

**View your report in Report view**

Report view is the default view that is used when you double-click a report in the Navigation Pane. If the report is not open, double-click the report in the Navigation Pane to see it in Report view.

If the report is already open, right-click the report name in the Navigation Pane and then click **Report View**.

**Work with your data in Report view**

In Report view, you can select text and copy it to the clipboard. To select entire rows, click and drag in the margin next to the rows that you want to select. You can then copy these rows to the clipboard by doing one of the following:

- On the **Home** tab, in the **Clipboard** group, click **Copy**.
- Right-click the selected rows and then click **Copy**.

**Keyboard shortcut** Press CTRL+C.

**Show only the rows you want by using filters**

You can apply filters directly to your report without leaving Report view. For example, if you have a "Country/region" column and you want to see only those rows where the country/region is "Canada", do the following:

1. Find the word "Canada" in the report and right-click it.
2. Click **Equals "Canada"**.

Access will create and apply the filter.

**Create a more detailed filter**

1. Right-click the field that you want to filter.
2. Click **Common Filters**.
3. Click the filter condition that you want.
4. Enter your criteria.
Toggle a filter on and off

You can switch between a filtered and non-filtered display by clicking Toggle Filter in the Sort & Filter group of the Home tab. This does not remove the filter — it just turns it on and off.

Remove a filter

1. Right-click the field from which you want to remove the filter.
2. Click Remove Filter.

Once a filter has been removed, you cannot switch it back on by using the Toggle Filter command. You must first re-create the filter.

**NOTE** If you apply a filter to a report and then save and close the report, the filter will be saved. However, the next time you open the report, Access will not apply the filter. To reapply the filter, on the Home tab, in the Sort & Filter group, click Toggle Filter.

Preview your report by using Print Preview

Right-click the report in the Navigation Pane, and then click Print Preview on the shortcut menu.

You can use the navigation buttons to view the pages of a report sequentially or to jump to any page in the report.

1. Click to display the first page.
2. Click to display the previous page.
3. Click to display the next page.
4. Click to display the last page.
5. Type a page number in this box and then press ENTER to jump to a specific page.

In Print Preview, you can zoom in to see details or zoom out to see how well the data is positioned on the page. With the cursor positioned over the report, click once. To reverse the effect of the zoom, click again. You can also use the zoom control on the Access status bar to zoom further in or out.

To close Print Preview, do one of the following:
On the **Print Preview** tab, click **Close Print Preview**.

Right-click the report in the Navigation Pane and then click **Layout View** or **Design View** on the shortcut menu.

**TIP** After previewing your report, you can export the results to Microsoft Office Word 2007, Microsoft Office Excel 2007, or several other Office programs. On the **External Data** tab, in the **Export Data** group, click the button for the format that you want and follow the instructions.

**Print your report**

You can print a report while it is open in any view, or even while it is closed. Before you print, be sure to double-check the page settings, such as the margins or page orientation. Access saves the page settings with the report, so you need to set them only once. You can set them again later, if your printing needs change.

**Change the page settings**

1. Open the report in **Print Preview**. You can change page settings in any view, but Print Preview is best because you can see the effects of any changes immediately.

2. On the **Print Preview** tab, in the **Page Layout** group, click **Portrait** or **Landscape** to set the page orientation, **Size** to set the paper size, **Margins** to adjust the margins, and so on.

3. After you make a change, use the navigation buttons to view several pages to ensure that you haven’t created any formatting problems on later pages.

**Send your report to a printer**

1. Open the report in any view, or select the report in the Navigation Pane.

2. Click the **Microsoft Office Button**, and then click **Print**.

   Access displays the **Print** dialog box.

3. Enter your choices for options such as printer, print range, and number of copies.

4. Click **OK**.

**Send your report as an e-mail message**

You can send your report to recipients as an e-mail message instead of printing a paper copy:
1. In the Navigation Pane, click the report to select it, click the Microsoft Office Button, and then click E-mail.

2. In the Send Object As dialog box, in the Select Output Format list, click the file format that you want to use.

3. Complete any remaining dialog boxes.

4. In your e-mail application, type the message details and send the message.
DATA COLLECTION

Microsoft Office Access 2007 makes it easy to gather data from people who are located anywhere on the globe, such as members of your sales team, survey participants, or contacts. Office Access 2007 works with Microsoft Office Outlook 2007 to help you to generate and send an e-mail message that includes a data entry form. When the recipients fill out the forms and send them back to you, the replies are processed according to your specifications. For example, if you choose to have the replies automatically processed, the contents of the form are added to the appropriate table in your database as soon as the reply reaches your inbox. This new feature, the Collect data through e-mail messages Wizard, can save you hours that you might have otherwise spent entering data on behalf of your users.

When to use data collection

The following list explores some scenarios that can utilize this new feature.

Surveys  You want to do a survey and compile the results in Access. You first create an Access database that has tables necessary to store the results. You then use the wizard to generate a form that includes the questions (presented as fields) and mail them to the survey participants. When participants reply, their answers go directly to the table that you specify in the database.

Status reports  Whether it is the latest inventory levels or up-to-date information on pending issues, your team can send you e-mail messages that contain the current information at regular intervals to keep you posted.

Event management  When organizing an event, such as a conference or training, you can send one or more forms as an e-mail message for gathering contact information, travel and hotel preferences, and so on. If you choose to have the replies automatically processed, the participants are able to change their preferences at any time without having to notify you, and you always have access to the latest data for decision making purposes.

To make it easier for you to generate and send the data entry form as an e-mail message, you use the Collect data through e-mail messages Wizard to walk through all of the major steps in the process, including specifying how you want the replies processed when they reach your inbox.

1. Fields of the following data types cannot be collected by using e-mail messages:

   - Attachment
   - AutoNumber
   - Multi-valued fields
   - OLE
2. If your data collection operation populates two or more tables, you must create a select query and use that as the form's record source. Ensure that the query includes all of the required fields from the underlying tables. If you are using an existing query, ensure that the query is not read-only and that you have the necessary permissions to add to or update its contents.

3. In most cases, you will be able to decide whether you want to store the collected data as new records, or to use the data to update existing records. In the following situations, you will only be able to store the data as new records:
   - You are collecting data to populate two or more tables.
   - The underlying table does not have a primary key field. The primary key values are necessary to map each reply to an existing record. If your destination table does not have a primary key field, either add it now or assign an existing field that has unique values as a primary key.
   - The underlying table does not have any records. If the table is empty, the wizard assumes that you want to add records.
   - The e-mail addresses of the recipients are not stored as a field in the database. When collecting data to update records, you will not be able to manually type the addresses in the wizard-generated message. The address field must be in the destination table, or in a table that has a relationship with the destination table. For example, if you are collecting data to update the Orders table, the addresses must be stored as a field either in the Orders table or in a related table (such as the Customers table).

**Using The Wizard**

1. Open the destination database.

2. To populate a single table, select the table in the Navigation Pane. To populate two or more related tables, select the query that is bound to these tables.

3. Do one of the following to start the wizard:
   - On the **External Data** tab, in the **Collect Data** group, click **Create E-mail**.
   - Right-click the table or query, and then click **Collect and Update Data via E-mail**.

If the table does not contain any fields, or has fields only of types AutoNumber, OLE Object, Attachment, or multivalued Lookup, Access displays the message **The selected table or query does not have any fields that support collecting data using e-mail.**
If the table contains fields that support data collection, the wizard starts. The first page of the wizard displays the major steps in the process. If the destination table supports both the adding and the updating of data, you perform six major steps in the wizard:

4. Click **Next**.

   The wizard prompts you to select the type of form you want to create.
Choose the type of data entry form

In this step, you must choose to create either an HTML form or an InfoPath form. As mentioned earlier in this article, an Access form cannot be used to collect data through e-mail messages — you must either use an HTML form or an InfoPath form that you create in the wizard.

If InfoPath is not installed on your computer, the Microsoft Office InfoPath form option is unavailable.

The type of form that you create depends on two factors — ease of use, and whether all of your recipients have the necessary software installed on their computers. An InfoPath form is much easier to use, but an HTML form involves fewer software requirements.

An InfoPath form offers a better data entry and editing environment. In addition, an InfoPath form can perform preliminary validation of the data when the user clicks the Send button, giving the user a chance to correct incorrect data before they send the reply to you.

To summarize, an InfoPath form has several advantages over an HTML form, but an HTML form can be viewed and edited by any user whose e-mail client supports HTML.

1. In the wizard, select the Microsoft Office InfoPath form option only if all of your recipients have both Office InfoPath 2007 and Office Outlook 2007 installed. Otherwise, select the HTML form option.
2. Click Next.
The wizard page that is displayed next depends on whether the destination object supports the updating of data. If the object is a query based on two or more tables, or if it is a table that does not have a primary key field or does not contain any records, the wizard assumes that you want to add new records, and prompts you to select the form fields. In all other cases, the wizard prompts you to specify whether you want to add or update data before asking you to select the form fields.

**Specify what you want to do with the data**

In this step, specify whether you want to add new records to the database or to update existing records.

The type of form that you are using affects the number of new records that a recipient can send to you in a single reply. When updating data, the number of records that must be updated by a recipient identifies the number of pre-completed forms that will be included in a message. The following table summarizes the various scenarios:
<table>
<thead>
<tr>
<th>Type of form</th>
<th>Add or update</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>HTML</td>
<td>Add</td>
<td>Recipients will be able to send you no more than one new record in each reply.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NOTE After you specify the fields that you want to include in your message, a page in the wizard appears on which you can set several options. On this page, you can set the Outlook folder in which replies will be processed, and also set options for how you want those replies to be processed.</td>
</tr>
<tr>
<td>InfoPath</td>
<td>Add</td>
<td>Recipients will be able to send you multiple new records in each reply. They can do this by clicking <strong>Insert a row</strong> at the bottom of the e-mail message.</td>
</tr>
<tr>
<td>HTML</td>
<td>Update</td>
<td>Each e-mail message will include one or more pre-filled forms, depending on the number of records that correspond to a single e-mail address. The recipient will be able to review and update each of the forms in the message.</td>
</tr>
<tr>
<td>InfoPath</td>
<td>Update</td>
<td>Each e-mail message will include one or more pre-filled forms, depending on the number of records that correspond to a single e-mail address. The recipient will be able to review and update each of the forms in the message. In addition, the user can send additional records by clicking <strong>Insert a row</strong> at the bottom of the e-mail message. Later in this article, you will learn how to prevent the user from adding new records to an update request.</td>
</tr>
</tbody>
</table>

1. In the wizard, select **Collect new information only** or **Update existing information**.

   It is important to note that if your goal is add new records, you can type the e-mail addresses in the address box of the e-mail message when the message is created. However, if your goal is to update existing data, the e-mail addresses of the recipients must be stored as a field in the underlying table or query, or in a related table.

2. Click **Next**.

   The wizard prompts you to select the fields that you want to include in the form.

**Select the form fields**

In this step, you pick the fields that you want to include in the form.
It is not generally necessary to include every field that exists in the underlying table or query in the form. However, there are two exceptions:

**Required fields** If you are collecting new records, the wizard will automatically include all fields whose **Required** property is set to **Yes**. If any record's required fields are blank, Access fails to add the record to the table.

**Unsupported field types** You will not be able to include certain fields in the form. The wizard does not support AutoNumber, Attachment, OLE Object, or multivalued lookup fields. Fields of these types will not be displayed in the wizard's **Fields in table** or **Fields in query** list. AutoNumber fields in the table will automatically be populated when new records are added. You will have to populate OLE Object, attachment, and multi-valued lookup fields either in Datasheet view or in Form view, because a data collection process cannot add these values.

**Primary key field** The following table summarizes when you will be able to include a primary key field in a form:
1. In the **Fields in table** or **Fields in query** list, double-click the fields that you want. If you want to include all of the fields, click > >.

2. Use the up and down arrow buttons to rearrange the fields in the **Field to include in e-mail message** list.

3. For each included field, under **Field Properties**, specify a caption. Click **Read-only** if you are updating data and want to display the field for the benefit of the user, but you don't want the user to change the data. The field appears in the e-mail message with the caption **This field is read-only**. This feature is most useful if the user is updating existing data.

4. Click **Next**.

   The wizard prompts you to specify how you want the replies processed.

**Specify how you want to process the data**

In this step, you make a very important decision regarding how you want the replies processed — automatically or manually. Note that manual processing in this context does not imply tedious data entry in Datasheet or Form view. It means only that you manually start the export operation to transfer the collected data to the destination table.
Automatic processing

If you choose to have the replies automatically processed, when the replies reach your mailbox Outlook and Access work together to export the form contents of each of the replies to the destination tables in your database.

Automatic processing can save you considerable time and effort. Replies are successfully exported as long as the following conditions are met at the time the replies reach your mailbox:

- Outlook must already be running on your computer. If Outlook is not running, processing starts the next time that you start Outlook.
- Access must be installed on your computer.
- The database must not be password-protected, and should not be open in Exclusive mode. The name or location of the database must not have changed since you sent the e-mail message.
- The names of the tables and queries, and the properties of the fields included in the form, must not have changed since you sent the e-mail message.
- You must still have the required permissions to add or update the contents of the underlying tables and query.

If one or more of these conditions are not met, automatic processing will fail. If processing fails, try fixing any issues, and then manually export the replies that failed. Any replies that reach your inbox after you resolve the issues continue to be processed automatically.
Allowing only updates to data

If you are updating data and you select theAutomatically process replies and add data tocheck box, the Only allow updates to existing data check box becomes available. Select the check box if you don't want the user to be able to send new records. If you are only adding new data, the Only allow updates to existing data check box is not visible.

Manual processing

If you want to control when and which replies are processed, clear theAutomatically process replies and add datato check box. In this case, the replies reach your inbox, but are not transferred to the database. You must manually select and right-click each reply in Outlook, and then click Export data to Microsoft Access in the shortcut menu to populate the database.

You might also have to manually process the replies that failed to be processed automatically. After you resolve the issue that caused the failure, you must manually export each of the existing replies.

If the database is password-protected, you are prompted to enter the password when you start the export operation. Also, the database should not be open in exclusive mode, and the name or location of the database must not have changed since you sent the e-mail message.

The names of the tables and queries, and the properties of the fields included in the form, must not have changed since you sent the e-mail message.

You must have the required permissions to add or update the contents of the underlying tables and query.

Specifying additional processing options

1. On the Specify how you want to process the replies page of the wizard, review the name of the Outlook folder where replies are stored. If you want to specify a different folder for the replies to this data collection request, click the folder name. In the Select Folder dialog box, either select a different folder, or click New to create a new folder. Click OK, and then switch back to Access.

2. Click Set properties to control the automatic processing of replies to display the Collecting Data Using E-mail Options dialog box.
Use this dialog box to specify how you want the replies processed. If you want to manually process the replies, skip the next step.

3. In the **Collecting Data Using E-mail Options** dialog box, review and, if necessary, change the settings in any of the following ways, and then click **OK**:

- **Discard replies from those to whom you did not send the message**  Select this check box if you want only those replies that were sent by the original recipients of your message to be automatically processed. Replies from other people are stored in the destination folder, but are not automatically processed.

- **Accept multiple replies from each recipient** A recipient can send you multiple replies. Select this check box if you want only the first reply from each recipient to be processed automatically. The second and subsequent replies are stored in the destination folder, but are not automatically processed.

**NOTE**  This setting only controls the number of replies, and not the number of records within a single reply, that are processed. In other words, if you send an InfoPath form, a user is able to send you multiple records in a single reply, and Access automatically processes all of the records in the reply, even if this check box is not selected.

- **Only allow updates to existing data**  When recipients use an InfoPath form to update data, they can send you new records in addition to updates to existing records. Select this check box if you want to process only the updates to existing records.
- **Number of replies to be processed**  Type the total number of replies (from all recipients) that you want automatically processed. If you want all replies to be automatically processed, enter a large value, such as 5000, in the text box. Replies that are received after the specified value is reached are stored in the destination folder, but are not automatically processed.

- **Date and time to stop**  Specify when automatic processing of replies should stop for this e-mail message. Replies received after this date and time are stored in the destination folder, but are not automatically processed.

**NOTE**  To change these options at a later date, on the **External Data** tab, in the **Collect Data** group, click **Manage Replies**. In the **Manage Data Collection Messages** dialog box, select the message for which you want to change the settings, and then click **Message Options**. The changes you make in the dialog box affect all subsequent replies that you receive for that message.

4. Click **OK**, and then click **Close**.

The next step depends on whether you are adding data or updating it. If you are adding new records, continue with the next section.

**Select how you want to specify the e-mail addresses of the recipients**

If you are collecting new information only, you can specify the e-mail addresses in two ways:

![Collect data through e-mail message dialog box](image)

Type the addresses individually in the e-mail message that is generated by the wizard, or select the addresses from an address book.
Use a field in the current database that contains e-mail addresses. The field must be in the underlying table or query, or in a related table.

When you are collecting data to update existing records, you do not see this dialog box, because in that case the recipients' e-mail addresses must be available as a field in the database.

1. In the wizard, select the option that you want.
2. Click Next.

**Specify the e-mail address field**

In this step, specify the field that contains the recipients' e-mail addresses.

If the field is in the current table or query, select **The current table or query**, select the field from the drop-down list, and then click Next.

If the field that contains the recipients' e-mail addresses is not in the current table or query, use the following procedure:

1. Select **An associated table**.
2. In the drop-down list, select the field in the current table that joins it to the table that contains the addresses. This is usually an ID field.
3. Do one of the following:
If the field that you select is associated with just one table, one additional drop-down list appears. Select the field that contains the e-mail addresses.

If the field that you select is associated with more than one table, two additional drop-down lists appear. In the first list, select the table that contains the e-mail addresses. In the second list, select the field.

4. Click Next.

Associated tables are those that have relationships defined between them. To view or edit the relationships in your database:

On the Database Tools tab, in the Show/Hide group, click Relationships.

When you choose to use an address field, you cannot preview or customize the e-mail message in Outlook. Instead, you do this in the wizard. In the next step, the wizard displays the default subject and body of the message, and you have the opportunity to customize it.

**Customize the e-mail message**

In this step, you review the components of the message and make necessary changes.

1. In the **Subject** and **Introduction** fields, make the changes that you want.
2. If you chose to use e-mail addresses that are stored in a field in the database, there is an additional choice you can make on this page. Under **Add recipients' e-mail addresses in the:**, select one of the options. Regardless of the option
that you select, the users will receive the e-mail message. If you chose to enter the e-mail addresses in Microsoft Office Outlook, this choice is not available.

3. Click **Next**.

**Create and send e-mail messages**

The wizard displays a page informing you that you can now create the message, and also shows you how to view e-mail status by using the **Manage Replies** command.

Some warning messages might appear on this page. The following table describes each warning and the action you can take to resolve it.

<table>
<thead>
<tr>
<th>Warning</th>
<th>Description</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Some records do not contain a valid address in the specified e-mail address field. No data will be returned for these rows.</td>
<td>The e-mail address field that you selected contains null values.</td>
<td>If you want to collect data for every record, exit the wizard and replace the null values with e-mail addresses. Then start the wizard again.</td>
</tr>
<tr>
<td>You currently have an exclusive lock on the database; automatic processing will fail until the lock is released.</td>
<td>You have the database currently open in exclusive mode.</td>
<td>If you chose to have the replies automatically processed, processing fails because Access cannot add to or update a database that has an exclusive lock on it. Close and reopen the database in non-exclusive mode immediately after sending the message.</td>
</tr>
<tr>
<td>These e-mail messages might contain data that is of a confidential or sensitive nature.</td>
<td>You are collecting data to update existing records, and the form that you are about to send will be pre-completed with existing data.</td>
<td>If some form fields include sensitive data, go back to the wizard step where you selected the fields and remove the fields that contain sensitive data from the form.</td>
</tr>
</tbody>
</table>
The next steps you take depend on whether you are specifying the e-mail addresses yourself, or whether you are using addresses stored in a table in your database.

**If you are choosing to specify the addresses in the Outlook e-mail message**

In this scenario, you enter the e-mail addresses in Outlook, and can preview and customize the message before clicking the **Send** button.

1. Click **Create** to continue.

   An Outlook message containing a data entry form is displayed. The message body includes a brief introduction and a form containing controls and hints. It is highly recommended that you do not make any changes to the message body. If the form structure is altered, the reply might fail to be processed.

2. Type the e-mail addresses of the recipients in the **To**, **Cc**, or **Bcc** boxes. You can also click the **To**, **Cc**, or **Bcc** buttons to select addresses from an address book.

3. Click **Send**.

**If you are choosing to use an address field stored in the database**

In this scenario, you have already previewed and customized the message. You now filter the e-mail address field so that you can select the addresses of users to whom the message is sent.

1. Click **Next** to display the **Send the e-mail message to your recipient’s** page.
2. Choose the e-mail addresses that you want to use by selecting the corresponding check boxes.

3. Click **Send**.

If some of the values in the address field are not valid e-mail addresses, a dialog box listing the invalid addresses is displayed. In this situation, make a note of the addresses in the list, click **Exit**, verify the addresses, and then try sending the message again.

You have now completed most of the work that is involved in collecting data by using e-mail messages. If you have chosen to have the replies automatically processed, and if no errors occur, the data will be transferred to the destination database without any further action on your part.

On the other hand, if you have chosen to manually process the replies, or if errors occur, you still have actions to take.

**After you send the e-mail message**

To respond to the e-mail message, each recipient clicks **Reply**, fills in the requested information on the form, and then clicks **Send**. This section tells you how to view the replies and what to do if any of them are not processed correctly.

**Viewing replies**

Regardless of how you chose to have the replies processed, you might be interested in finding out who responded to your message, and you might also want to open the replies manually. To view the replies, do the following:

1. Switch to Outlook, and then browse to the folder that you designated for storing data collection replies.

   **TIP** If you don't remember the name of the folder, on the **External Data** tab, in the **Collect Data** group, click **Manage Replies**. In the **Manage Data Collection Messages** dialog box, you will find the folder name in the **Outlook Folder** column, in the row corresponding to the message whose replies you want to view.

2. To open a reply in Outlook, double-click it. You will see the form, as it was completed by the sender.

   Access will not process replies to an original reply message. Therefore, if you see that one or more forms from recipients are empty, incomplete, or not completed properly,
you must resend the original e-mail message to those users, instead of using the **Reply** command.

Similarly, if you want to send the request to additional people, you must resend the original message, instead of forwarding it.